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Overview of Microsoft Excel 
 
Start Microsoft Excel 
To start Microsoft Excel, click the Start button, click All Programs, click Microsoft Office, and then click 
Microsoft Excel. 
 
 
Rows, Columns & Cells 
A row is represented by the numbers listed down the left panel of the worksheet. 
 

Shortcut(s): Select Row: Shift + Spacebar
Insert Row: Alt + H + I + R 

 
A column is represented by the letters listed across the top panel of the worksheet. 
 

Shortcut(s): Select Column: Ctrl + Spacebar
Insert Column: Alt + H + I + C

 
A cell is the box formed by the intersection of a row and column in a worksheet, in which you enter information.  
The cell reference is the set of coordinates that a cell occupies on a worksheet.  For example, the reference of 
the cell that appears at the intersection of column B and row 3 is B3.  The active cell is the selected cell in 
which data is entered when you begin typing.  Only one cell is active at a time.  The active cell is bounded by a 
heavy border. 
 
 
Worksheets & Workbooks 
Also called a spreadsheet, a worksheet is the primary document that you use in Excel to store and work with 
data.  A worksheet consists of cells that are organized into columns and rows.  A worksheet is always stored in 
a workbook. 
 
A workbook is a spreadsheet program file that you create in Excel.  A workbook contains worksheets. 
 
 
Save & Save As 
Save overwrites the original document with all of your changes. 

 
Shortcut(s): Save: Ctrl + S 
 

Save As creates a new file from your existing document. 
 

Shortcut(s): Save As: Alt + F + A 
 
 
Numbers, Formulas & Text 
Numbers can be used in calculations.  By default, numbers are right-aligned in a cell. 
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Formulas are equations that perform calculations on values in your worksheet.  A formula starts with an equal 
sign (=).  A formula can contain functions, references, operators, and/or constants. 
 
Text is usually comprised of words that are used for worksheet headings or labels for identifying columns of 
data.  By default, text is left-aligned in a cell. 
 
 
Row Heights & Column Widths 
To change the height of a row, drag the boundary below the row heading until the row is the height that you 
want. 
 

Shortcut(s): Manual Fit Row Height: Alt + H + O + H
Auto Fit Row Height : Alt + H + O + A

 
To change the width of a column, drag the boundary on the right side of the column heading until the column is 
the width that you want. 
 

Shortcut(s): Manual Fit Column Width: Alt + H + O + W
Auto Fit Column Width: Alt + H + O + I

 
 
Cut, Copy & Paste 
The Cut function moves the entire cell, including formulas and cell formats.  Cell references are not adjusted. 
 

Shortcut(s): Cut: Ctrl + X 
 
The Copy function copies the entire cell, including formulas and cell formats.  Cell references are 
automatically adjusted. 
 

Shortcut(s): Copy: Ctrl + C 
  

The Paste function inserts the contents of the Clipboard at the insertion point and replaces any selection. 
 

Shortcut(s): Paste: Ctrl + V 
 
 
Fill 
The Fill command quickly fills cells with the contents of an adjacent cell. 
 

Shortcut(s): Fill Down: Ctrl + D 
Fill Right: Ctrl + R 

 
 
Relative, Absolute & Mixed Cell References  
A formula that contains a relative cell reference changes as you copy it from one cell to another.  If you copy or 
fill the formula across rows or down columns, the reference automatically adjusts.  
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An absolute cell reference will always refer to a cell in a specific location.  If you copy or fill the formula across 
rows or down columns, the absolute reference does not adjust.  You can make a cell reference absolute by 
preceding the column and row with a dollar sign—for example, $A$2.  
 
A mixed cell reference has either an absolute column or a relative row, or absolute column and relative row.  If 
you copy or fill the formula across rows or down columns, the relative reference automatically adjusts, and the 
absolute reference does not adjust.  You can make a mixed cell reference by preceding either the column or 
the row value with a dollar sign to "lock" either the column or the row—for example, $A2 or B$3.   
 
Press F4 to switch between the reference types. 

 
 

Functions 
On a worksheet, you can enter simple formulas to add, divide, multiply, and subtract two or more numeric 
values.  All formula entries start with an equal sign (=).  For simple formulas, you type the equal sign followed 
by the numeric values you that you want to calculate and the math operators that you want to use—for 
example, =10+5. 
 
Functions are predefined formulas that perform calculations by using specific values in a particular order or 
structure.  Frequently used Excel functions include SUM, AVERAGE, MIN, and MAX.  For example, =SUM(A1:A5) 
adds all the numbers that are contained in cells A1 through A5. 
 
Click Insert Function to the left of the formula bar to search for a function. 
 
 
CONCATENATE 
The CONCATENATE function in Excel allows you to join several text strings into one text string.  The syntax is 
as follows: 
 
=CONCATENATE(text1,text2,...) 
 
Text1, text2, … are 1 to 30 text items to be joined in a single text item. 
 
You can also use the ampersand (&) operator instead of the CONCATENATE function to join text items.  For 
example, =A1&B1 returns the same value as =CONCATENATE(A1,B1). 
 
 
Text to Columns 
You can use the Text to Columns Wizard in the Data tab to separate simple cell content into different columns.  
Depending on the way your data is arranged, you can split the cell content based on a delimiter, such as a 
space or a character, or you can split it based on a specific column break location within your data.  
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Useful Shortcut Keys 
 
Title Key Description 

Copy Ctrl + C Copies the selected cells. 

Cut Ctrl + X Cuts the selected cells. 

Edit cell F2 
Edits the active cell and positions the insertion point at the end of the 
cell contents.  Also shows precedents for the arguments in a formula. 

Fill Down Ctrl + D 
Uses the Fill Down command to copy the contents and format of the 
topmost cell of a selected range into the cells below. 

Fill Right Ctrl + R 
Uses the Fill Right command to copy the contents and format of the 
leftmost cell of a selected range into the cells to the right. 

Format Cells Ctrl + 1 Displays the Format Cells dialog box. 

Lock cell F4 
Cycles through all the various combinations of absolute and relative 
references when a cell reference or range is selected in a formula. 

Outline 
Border Ctrl + Shift + & Applies the outline border to the selected cells. 

Paste Ctrl + V Pastes the selected cells. 

Paste Special Alt + E + S Displays the Paste Special dialog box. 

Select Cell 
Shift + Arrow 
Key Extends the selection of cells by one cell. 

Select Range 
Ctrl + Shift + 
Arrow Key 

Extends the selection of cells to the last nonblank cell in the same 
column or row as the active cell. 

Switch 
Workbook Ctrl + Tab Switches between workbooks. 

Switch 
Worksheet 

Ctrl + 
PgUp/PgDn Switches between worksheet tabs. 

Undo Ctrl + Z 
Uses the Undo command to reverse the last command or delete the last 
entry that you typed. 

 
Note: To display the S&P Capital IQ ribbon’s keyboard shortcuts in Excel 2010, press Alt + C.  You can also modify 
the S&P Capital IQ shortcut keys under Customize > Manager in the S&P Capital IQ ribbon. 
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Quick Tips 
• To populate a cell with the data item, select the data item in the tree, hold down the mouse button, and 

then drag the data item to the cell, e.g. IQ_TOTAL REV. 
• To populate a cell with the data item name, shift-select the data item in the tree, hold down the mouse 

button, and then drag the data item to the cell, e.g., Total Revenue. 
• To populate a cell with the data item definition, control-select the data item in the tree, hold down the 

mouse button, and then drag the data item to the cell. 
 
 
Data Sets 
S&P Capital IQ offers a variety of data sets within the S&P Capital IQ Excel Plug-in, ranging from Company 
Information and Financials to Macroeconomic Data.  Depending on which set of data you are interested in 
pulling, the syntax will change slightly.  The data sets are organized into the following tabs in the Formula 
Builder: 
 
Financials Estimates Market Data Trading Multiples
Formulas relating to a 
company’s financial 
statements and operating 
statistics 
 

Formulas relating to 
estimates for CIQ and 
Thomson 
 

Formulas relating to market 
data, including equity 
market data, fixed income, 
commodities, and credit 
ratings 
 

Formulas relating to trading 
multiples, both trailing and 
forward 

Company Information Transactions Economic Data  
Formulas relating to 
qualitative company and 
profile data, including news, 
professionals, ownership, 
and private equity 
 

Formulas relating to 
qualitative and quantitative 
transaction-specific data 
for M&A, spin-offs and split-
offs, private placements, 
buybacks, public offerings, 
and bankruptcies 
 

Formulas relating to 
macroeconomic data, both 
historical and forecast 
 

 

 

   



 

S&P Gl
 

Bu
Es
 

• 
• 
• 
• 
• 
• 
• 
• 

 
The pa
estima
Setting
 
Param

• 

• 

 
 
Param
Metric
a folde
 

Standa
S&P Ca
templa
compa
 
Our tem
Real Es
Regula
Keizai. 
 
Click th
templa
the def

 
 

obal Market 

uildin
tima
Parameter
Parameter
Parameter
Parameter
Parameter
Parameter
Parameter
Parameter

arameters in
ates, and th
gs. 

meter 1: Tic
For compa
or the CIQ 
The Identif
empty cell 

meter 2: “IQ
cs are organ
er or double

ardized Dat
apital IQ stan
ates so compa
red correctly

mplates inclu
state, Financ
tory Data (U.

he dropdown 
ate you would
fault templat

Intelligence 

ng Fo
ates 

r 1: Ticker or
r 2: Metric ("
r 3: Period Ty
r 4: "As of" D
r 5: Filing Ve
r 6: Date Com
r 7: Currency
r 8: Currency

n bold are re
e "As of" Da

cker or CIQ 
anies, the ide
ID (e.g., IQ2
fier Lookup 
and select 

Q_DATAPOI
ized into fol
-click the fo

ta 
dardizes all 
anies in simi

y. 

ude Standard
cial Services, 

S.), Thrift Re

above the m
d like to view.
te. 

 

rmul

r CIQ Identif
"IQ_DATAPO
ype 

Date 
ersion (Finan
mparison 
y Type 
y Conversion

equired.  Pe
ate will defa

Identifier 
entifier can 
1719). 
can help yo
Insert CIQ Id

INT” 
lders (e.g., I
older name t

historical dat
lar industries

d, Banks, Insu
Capital Mark
gulatory Data

metrics to sele
.  The Standa

las fo

fier 
OINT") 

ncials) or Co

n Mode 

riod types n
ault to today

be written a

u look up id
dentifiers.

ncome Stat
to expand t

ta into specif
s can be 

urance, Utilit
kets, Bank 
a, and Toyo 

ect the 
ard template 

or Fin

onsolidation

not specified
y.  All other p

as Exchang

entifiers.  T

tement, Bala
he folder an

fic 

y, 

is 

nanc

n (Estimates

d will defau
parameters

e:Ticker (e.g

To access th

ance Sheet
nd display th

ials &

s) 

lt to LTM fo
 will default

g., NYSE:SP

e Identifier 

, Cash Flow
he full list o

& 

r financials 
t to the opti

PGI for S&P 

Lookup, rig

, etc.).  Click
f metrics. 

and NTM fo
ons in 

Global, Inc.)

ght-click on 

k the + next

10

or 

) 

an 

t to 



 

S&P Global Market Intelligence 11
 

Parameter 3: Period Type 
Relative References 
You can choose from relative period types for formulas to get automatic updates when new numbers are 
available.  These period types can be modified using the +/- dropdown to go back historically or forward for 
estimates (e.g., IQ_FY-1, IQ_FY+1).  
 
In addition, S&P Capital IQ has assigned a numerical value to relative period types so you can easily add or 
subtract the reference number to retrieve future or historical information. 
 

Relative Period Types 

IQ_FY 1000 Fiscal 
Year IQ_FH 100000 Fiscal Half IQ_FH 100000 Fiscal Half 

IQ_CY 10000 Calendar 
Year IQ_CH 110000 Calendar 

Half IQ_CH 110000 Calendar 
Half 

IQ_LTM 2000 
Last 

Twelve 
Months 

IQ_YTD 3000 Year to Date IQ_YTD 3000 Year to Date

 
• Last Twelve Months (LTM) 

S&P Capital IQ calculates LTM results for a particular period end date by adding the difference of the financials 
from the year-to-date period on that date and the corresponding year-to-date period from the prior year, to the 
financials from the most recently completed fiscal year results as of that date. 
 
S&P Capital IQ does not sum four consecutive quarters of data to arrive at an LTM value as our goal is to incorporate 
the most recently available information in the LTM metric.  As quarterly and interim results are usually unaudited, 
companies often restate reported data from filing to filing throughout the year. 
 

• Next Twelve Months (NTM) 
NTM estimates are calculated using either the sum of the next four Quarterly Estimates or proportions of current 
and following Calendarized Estimates if Quarterly Estimates are not available. 
 

Absolute References 
Alternatively, you can choose to reference absolute periods to retrieve data for a specific time frame. 
 

Absolute Period Types 

FY#### e.g., FY2015 FQ##### e.g., FQ12015 FH##### e.g., FH12015 

CY#### e.g., CY2015 CQ##### e.g., CQ12015 CH##### e.g., CH12015 

 
 

Parameter 4: “As of” Date 
The "As of" Date represents the date that the selected metric is as of.  The "As of" Date will default to today if 
not specified. 
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Parameter 5: Filing Version (Financials) or Consolidation (Estimates) 
Filing Version 
For historical data, you can choose from various reporting types for the version of the filing you would like to 
use as the source of financials. 
 

Reporting Types 

L Latest 
Retrieves information from the 
most recent period, including 
press releases. 

P Preliminary Retrieves information directly from the 
press release only. 

O Original 

Retrieves information from the 
first appearance of the financial 
period in an SEC or other 
company filing prior to 
restatements. 

LRI 
Last 

Reported 
Instance 

Reviews the latest instance of the latest 
period end date in the financial statement 
that the specified data item is in.  If a value 
is not found within this instance, then it 
will retrieve a null value. 

LFR 
Latest 
Fully 

Reported 

Retrieves information only from 
full reported financial 
statements.  This option excludes 
press releases. 

LRP
Last 

Reported 
Period 

Reviews all instances for the latest period 
end date, and if a value is not found, it will 
then look at the closest previous period 
end date for the requested value. 

 
Consolidation 
You can choose to retrieve consolidated or unconsolidated estimates.  The consolidated (CON) option retrieves 
estimates for the parent company and all its subsidiaries.  The unconsolidated (UNC) option retrieves 
estimates for just the parent company without taking into consideration its subsidiaries. 
 
 
Parameter 6: Date Comparison 
You can choose the reference type for the filing you would like to use as the source of financials.  The compare 
date to period date (P) option retrieves financials as of the company’s period end date.  The compare date to 
filing date (F) option retrieves financials as of the company’s filing date. 
 
 
Parameter 7: Currency Type 
You can specify the currency type in which you want to display the data. 
 
 
Parameter 8: Currency Conversion Mode 
If you selected a foreign currency type, you can choose to convert the selected currency using historical or 
current exchange rates.  For financials, the historical (H) option uses the historical spot exchange rate on the 
period end dates.  The current (C) option uses the most recent foreign exchange spot rate available, applied 
across all historical periods. 
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Example(s): 

=CIQ ("NYSE:SPGI", "IQ_EBITDA", IQ_FY, "07/15/2016") 
This will provide you the fiscal year EBITDA value for S&P Global as of 07/15/2016. 
 
=CIQ ("NYSE:SPGI", "IQ_EBITDA", IQ_FQ, , , , "USD") 
This will provide you the most recently completed fiscal quarter EBITDA value for S&P Global in US dollars. 
 

Note: Remember to use placeholders (,,) for the unused parameters.  As stated earlier, parameters 3 & 4, if left 
blank, will default to IQ_LTM and today's date, respectively. 

 
=CIQ("NYSE:SPGI", "IQ_EBITDA_EST", IQ_FY + 1, "07/15/2016") 
This will provide you the next fiscal year EBITDA estimate for S&P Global as of 07/15/2016. 
 
=CIQ("NYSE: SPGI ", "IQ_EBITDA_EST", IQ_FQ + 1, , , , "USD") 
This will provide you the next fiscal quarter EBITDA estimate for S&P Global in US dollars. 

 
 

High Value, Low Value & Average Value Formulas for Financials 
 
To calculate the high, low, and/or average value for a financials metric, use a combination of a period type and 
an end date.  The key component to remember when constructing this formula is the 3rd parameter, period 
type.  In order to retrieve an accurate value, you must specify how many periods back in time you wish to go. 
  
The formula prefix will be =CIQHI, =CIQLO, or =CIQAVG. 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: "As of" Date 
• Parameter 5: Filing Version 
• Parameter 6: Date Comparison 
• Parameter 7: Currency Type 
• Parameter 8: Currency Conversion Mode 

 
The parameters in bold are required.  Period types not specified will default to LTM, and the "As of" Date will 
default to today.  All other parameters will default to the options in Settings. 
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Example(s): 

=CIQHI("NYSE:SPGI", "IQ_EBITDA", IQ_FY - 4, "07/15/2016") 
This will provide you the highest annual EBITDA figure for S&P Global over the last 5 fiscal years relative to the date 
specified. 
 
=CIQLO("NYSE: SPGI ", "IQ_TOTAL_REV", IQ_FQ - 1, IQ_TODAY) 
This will provide you the lowest quarterly revenue figure for S&P Global over the last 2 fiscal quarters relative to today. 
 
=CIQAVG("NYSE: SPGI ", "IQ_COGS", IQ_CY - 9) 
This will provide you the average annual cost of goods sold for S&P Global for the last 10 calendar years. 
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Parameter 4: Currency Type 
You can specify the currency type in which you want to display the data. 
 
 
Parameter 5: Currency Conversion Mode 
If you selected a foreign currency type, you can choose to convert the selected currency using historical or 
current exchange rates.   
 

Example(s): 

=CIQ("NYSE:SPGI", "IQ_MARKETCAP", "07/15/2016") 
This will provide you the market capitalization for S&P Global as of 07/15/2016. 
 
=CIQ("NYSE: SPGI ", "IQ_MARKETCAP", , "GBP") 
This will provide you the latest market capitalization for S&P Global in British Pounds. 

 

High Value, Low Value, Average Value & Percent Change 
Formulas for Market Data 
 
You can calculate the high, low, average and/or percent change of a market data metric over a specified time 
frame using either a start and end date or a period type. 
 
The prefix of the formula will be =CIQHI, =CIQLO, =CIQAVG, or =CIQPC. 
 
Method 1: Start Date and End Date 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Start Date 
• Parameter 4: End Date 
• Parameter 5: Currency Type 
• Parameter 6: Currency Conversion Mode 

 
The parameters in bold are required.  The End Date will default to today.  All other parameters will default to 
the options in Settings. 
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Example(s): 

=CIQHI("NYSE:SPGI", "IQ_MARKETCAP", "04/15/2013", "04/15/2016") 
This will provide you the highest market capitalization over the specified time frame for S&P Global. 
 
=CIQLO("NYSE:SPGI", "IQ_LASTSALEPRICE", "05/15/2013", "05/15/2016") 
This will provide you the lowest sale price over the specified time frame for S&P Global. 
 
=CIQAVG("NYSE:SPGI", "IQ_VOLUME", "06/15/2013", "06/15/2016") 
This will provide you the average volume over the specified time frame for S&P Global. 
 
=CIQPC("NYSE:SPGI", "IQ_TEV", "07/15/2013", "07/15/2016") 
This will provide you the percent change of the TEV over the specified time frame for S&P Global. 

 
Method 2: Period Type 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: Blank 
• Parameter 5: Currency Type 
• Parameter 6: Currency Conversion Mode 

 
The parameters in bold are required.  All other parameters will default to the options in Settings. 
 

Example(s): 

=CIQHI("NYSE:SPGI", "IQ_MARKETCAP", IQ_LTM) 
This will provide you the highest market capitalization over the most recently completed LTM period for S&P Global. 
 
=CIQLO("NYSE:SPGI", "IQ_LASTSALEPRICE", IQ_FQ) 
This will provide you the lowest sale price over the most recently completed fiscal quarter for S&P Global. 
 
=CIQAVG("NYSE:SPGI", "IQ_VOLUME", IQ_FY) 
This will provide you the average volume over the most recently completed fiscal year for S&P Global. 
 
=CIQPC("NYSE:SPGI", "IQ_TEV", IQ_CY) 
This will provide you the percentage change of the TEV over the most recently completed calendar year for S&P Global. 
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Building Formulas for Trading Multiples 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: "As of" Date 

 
The parameters in bold are required.  Period types not specified will default to LTM for trailing trading 
multiples and NTM for forward trading multiples, and the "As of" Date will default to today.  All other 
parameters will default to the options in Settings. 
 
Parameter 1: Ticker or CIQ Identifier 

• For companies, the identifier can be written as Exchange:Ticker (e.g., NYSE:SPGI for S&P Global, Inc.) 
or the CIQ ID (e.g., IQ21719). 

• The Identifier Lookup can help you look up identifiers.  To access the Identifier Lookup, right-click on an 
empty cell and select Insert CIQ Identifiers. 

 
 
Parameter 2: “IQ_DATAPOINT” 
Metrics are organized into folders (e.g., Trailing Trading Multiples, Forward Trading Multiples, etc.).  Click the + 
next to a folder or double-click the folder name to expand the folder and display the full list of metrics. 
 
 
Parameter 3: Period Type 
You can choose from various relative period types.  For trailing trading multiples, it is highly recommended that 
you use IQ_LTM.  This will retrieve the multiple that was available to the market as of a specified date. 
 
 
Parameter 4: “As of” Date 
The "As of" Date represents the date that the selected metric is as of.  The "As of" Date will default to today if 
not specified.  S&P Capital IQ calculates its trading multiples on a daily basis. 
 

Example(s): 

=CIQHI("NYSE:SPGI", "IQ_PE_EXCL", IQ_LTM, "05/15/2013", "05/15/2016") 
This will provide you the highest LTM P/E multiple over the specified time frame for S&P Global. 
 
=CIQLO("NYSE:SPGI", "IQ_TEV_EBITDA", IQ_LTM, "06/15/2013", "06/15/2016") 
This will provide you the lowest LTM TEV/EBITDA multiple over the specified time frame for S&P Global. 
 
=CIQAVG("NYSE:SPGI", "IQ_PBV", IQ_LTM, "07/15/2013", "07/15/2016") 
This will provide you the average LTM Price/Book Value multiple over the specified time frame for S&P Global. 
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High Value, Low Value & Average Value Formulas for Trading 
Multiples 
 
To calculate the high, low and/or average for a trading multiples metric, use a combination of a period type, 
start date, and end date. 
 
The prefix of the formula will be =CIQHI, =CIQLO, or =CIQAVG. 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: Start Date 
• Parameter 5: End Date 

 
The parameters in bold are required.  Period types not specified will default to LTM for trailing trading 
multiples and NTM for forward trading multiples, and the End Date will default to today.  All other parameters 
will default to the options in Settings. 
 

Example(s): 

=CIQHI("NYSE:SPGI", "IQ_PE_EXCL", IQ_LTM, "03/09/2009", "03/09/2012") 
This will provide you the highest LTM P/E multiple over the specified time frame for S&P Global. 
 
=CIQLO("NYSE:SPGI", "IQ_TEV_EBITDA", IQ_LTM, "04/09/2009", "04/09/2012") 
This will provide you the lowest LTM TEV/EBITDA multiple over the specified time frame for S&P Global. 
 
=CIQAVG("NYSE:SPGI", "IQ_PBV", IQ_LTM, "05/09/2009", "05/09/2012") 
This will provide you the average LTM Price/Book Value multiple over the specified time frame for S&P Global. 
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Building Formulas for Company 
Information 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 

 
The parameters in bold are required.   
 
Parameter 1: Ticker or CIQ Identifier 

• For companies, the identifier can be written as Exchange:Ticker (e.g., NYSE:SPGI for S&P Global, Inc.) 
or the CIQ ID (e.g., IQ21719). 

• The Identifier Lookup can help you look up identifiers.  To access the Identifier Lookup, right-click on an 
empty cell and select Insert CIQ Identifiers. 

 
 
Parameter 2: “IQ_DATAPOINT” 
Metrics are organized into folders (e.g., General, News, Professionals, etc.).  Click the + next to a folder or 
double-click the folder name to expand the folder and display the full list of metrics. 
 

Example(s): 

=CIQ("NYSE:SPGI", "IQ_COMPANY_NAME") 
This will provide you the full company name for S&P Global. 

 
Note: Most of the metrics in the General folder have only two parameters. 

 
 
  



 

S&P Global Market Intelligence 21
 

 

Building Formulas for Transactions 
 

 Parameter 1: CIQ Transaction ID 
 Parameter 2: Metric ("IQ_DATAPOINT") 
 Parameter 3: Blank 
 Parameter 4: Currency Type 
 Parameter 5: Currency Conversion Mode 

 
The parameters in bold are required.  All other parameters will default to the options in Settings. 
 
Parameter 1: CIQ Transaction ID 
To retrieve transaction data, you must begin with the transaction identifier.  To find a CIQ transaction ID, use 
one of the following options: 

 Search for a company in the Identifier Lookup, and then select the Show Transactions button at the 
bottom left of the window.   

 Click the S&P Capital IQ tab and select Screening in the Other Functions group to download screens 
from the platform. 

 Use the Transaction Lists data items from the Lists folder in the Company Info tab. 
 
 
Parameter 2: “IQ_DATAPOINT” 
To correctly retrieve data, you must ensure that you are using the appropriate metrics from the folder 
associated with the transaction identifier.  For example, metrics from the Public Offerings folder need to 
reference a transaction identifier for a public offering. 
 
 
Parameter 3: Blank 
This parameter is unused in transaction formulas. 
 
 
Parameter 4: Currency Type 
You can specify the currency type in which you want to display the data. 
 
 
Parameter 5: Currency Conversion Mode 
If you selected a foreign currency type, you can choose to convert the selected currency using historical or 
current exchange rates.   
 

Example(s): 

=CIQ("IQTR11733457", "IQ_TR_TARGETNAME") 
This will provide you the target name for the associated transaction ID. 
 
=CIQ("IQTR11733457", "IQ_TR_IMPLIED_EV", , "HKD") 
This will provide you the implied enterprise value of the associated transaction in Hong Kong Dollars. 
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Building Formulas for Economic Data 
 

 Parameter 1: Country ID 
 Parameter 2: Metric ("IQ_DATAPOINT") 
 Parameter 3: Period Type 
 Parameter 4: "As of" Date 
 Parameter 5: Blank 
 Parameter 6: Blank 
 Parameter 7: Currency Type 
 Parameter 8: Currency Conversion Mode 

 
The parameters in bold are required.  The "As of" Date will default to today.  All other parameters will default to 
the options in Settings. 
 
Parameter 1: Country ID 
To retrieve economic data, you must begin with the country identifier.  To find a country ID, use one of the 
following options: 

 Select Insert Country Identifiers from the right-click menu. 
 Click the Economic Data tab in the Formula Builder, and then search by country in the Identifier 

Lookup. 
 
 
Parameter 2: “IQ_DATAPOINT” 
Metrics are organized into folders (e.g., Global Historical, U.S., Global Forecast, etc.).  Click the + next to a 
folder or double-click the folder name to expand the folder and display the full list of metrics. 
 
 
Parameter 3: Period Type 
In addition to the period types available for financials, you can choose to retrieve data for the additional 
reporting period types below: 
 

Reporting Types 

IQ_MONTH Month 15000 

IQ_WEEK Week 50000 

 
 
Parameter 4: “As of” Date 
The "As of" Date represents the date that the selected metric is as of.  The "As of" Date will default to today if 
not specified. 
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Parameters 5 & 6: Blank 
These parameters are unused in economic data formulas. 
 
 
Parameter 7: Currency Type 
You can specify the currency type in which you want to display the data. 
 
 
Parameter 8: Currency Conversion Mode 
If you selected a foreign currency type, you can choose to convert the selected currency using historical or 
current exchange rates.   
 

Example(s): 

=CIQ ("US", "IQ_REAL_GDP", IQ_CY, "07/15/2016") 
This will provide you the calendar year gross domestic product value for the United States as of 07/15/2016. 
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Building Range Formulas 
 
The S&P Capital IQ Excel Plug-in allows you to pull in a range of metrics at once with just one formula.  The 
prefix for a range formula is =CIQRANGE.  The parameters will change depending on the data set you are 
retrieving.  The label refers to the text displayed for the cell in which the formula was built. 
 
By default, all range formulas will output data down a column.  To distribute the data across the row, use "A" 
at the end of the CIQRANGE so that the prefix of the formula is =CIQRANGEA. 
 
CIQRANGEV will provide a range of values, but the values will be hardcoded. 
 
Financials 
You can construct a range formula with almost every data item in the Financials tab.  The key component to 
remember when constructing this formula is the 3rd parameter, period type.  In order to receive an accurate 
range, you must specify how many periods back in time you wish it to go. 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: "As of" Date 
• Parameter 5: Filing Version 
• Parameter 6: Date Comparison 
• Parameter 7: Currency 
• Parameter 8: Currency Conversion Mode 
• Parameter 9: Label 

 
The parameters in bold are required.  The "As of" Date will default to today.  All other parameters will default to 
the options in Settings. 
 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_EBITDA", IQ_FY - 4, "07/15/2016", , , "USD") 
This will provide you the last 5 fiscal years of EBITDA for S&P Global relative to the date specified, in US Dollars. 
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Market Data 
You can construct a range formula with almost every data item in the Market Data tab.  However, there is a 5 
year limit when using the daily frequency. 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Start Date 
• Parameter 4: End Date 
• Parameter 5: Currency 
• Parameter 6: Currency Conversion Mode 
• Parameter 7: Sort Order 
• Parameter 8: Frequency 
• Parameter 9: Label 

 
The parameters in bold are required.  The End Date will default to today and the sort order will default to 
ascending.  All other parameters will default to the options in Settings. 
 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_CLOSEPRICE", "07/15/2015", "07/15/2016", "USD", , , "M") 
This will provide you the monthly stock prices for S&P Global between the two dates specified, in US Dollars. 

 
 
Trading Multiples 
You can construct a range formula for all trailing and forward trading multiples.  However, there is a 5 year 
limit when using the daily frequency. 
 
Trailing Trading Multiples 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: Start Date 
• Parameter 5: End Date 
• Parameter 6: Blank 
• Parameter 7: Sort Order 
• Parameter 8: Frequency 
• Parameter 9: Label 

 
The parameters in bold are required.  Period types not specified will default to LTM, the End Date will default 
to today, and the sort order will default to ascending.  All other parameters will default to the options in 
Settings. 
 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_PE_EXCL", IQ_LTM, "07/15/2015", "07/15/2016", , , "M", "P/Diluted EPS Before Extra") 
This will provide you the monthly LTM PE multiples for S&P Global between the two dates specified. 
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Forward Trading Multiples 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: Start Date 
• Parameter 5: End Date 
• Parameter 6: Consolidation 
• Parameter 7: Sort Order 
• Parameter 8: Frequency 
• Parameter 9: Blank 
• Parameter 10: Blank 
• Parameter 11: Label 

 
The parameters in bold are required.  Period types not specified will default to NTM, the End Date will default 
to today, and the sort order will default to ascending.  All other parameters will default to the options in 
Settings. 
 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_PE_EXCL_FWD", IQ_NTM, "07/15/2015", "07/15/2016", , , "M", , , "Forward P/E") 
This will provide you the monthly NTM PE multiples for S&P Global between the two dates specified. 

 
 

Company Information 
Many of the data items in the Company Information tab require a CIQRANGE formula to correctly retrieve data.  
These data items include the following: 
 
News 
Professionals 
Public Ownership 

Private Ownership 
Lists 
Private Equity 

Latest Analyst Coverage 
Government Assistance Programs 

 
You can change the Starting Rank and Ending Rank in these formulas to specify the number of data items you 
would like to retrieve. 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Starting Rank 
• Parameter 4: Ending Rank 
• Parameter 5: "As of" Date 
• Parameter 6: Blank 
• Parameter 7: Blank 
• Parameter 8: Blank 
• Parameter 9: Label 

 
The parameters in bold are required.  The "As of" Date will default to today. 
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Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_TRANSACTION_LIST", 1, 10, , , , , "All Transactions") 
This will provide you the last 10 transactions for S&P Global. 
 
=CIQRANGE("NYSE:SPGI", "IQ_HOLDER_NAME", 1, 5, , , , , "Holder Name") 
This will provide you the name of top 5 shareholders of S&P Global. 
 
=CIQRANGE("NYSE:SPGI", "IQ_HOLDER_SHARES", 1, 5, "07/15/2016", , , , "Holder Total Shares") 
This will provide you the holder total shares of the current top 5 shareholders of S&P Global as of 07/15/2016. 
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Building Range Formulas (Advanced) 
 
Segments 
The formulas for Business Segments and Geographic Segments in the Financials tab of the Formula Builder 
include options for Absolute and Relative Ranking.  The difference between Absolute Ranking and Relative 
Ranking is the order in which the segments are displayed. 
 

• Absolute Ranking retrieves the Business and Geographic Segments in the same order each and every 
year.  This is valuable when doing historical analysis.  Each segment is assigned a Segment ID Number 
that is locked in the database.  S&P Capital IQ determined the absolute rank of segments on January 
30, 2008.  New segments from filings following this date are assigned their own Segment ID Number 
and are added to the end of the list.  

 
• Relative Ranking retrieves the Business and Geographic Segments in the order exactly as they appear 

in the latest available financial document.  Inactive and discontinued segments are ranked below all 
other segments available from the latest financial document. 

 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_BUS_SEG_NAME_ABS", 1, 5, IQ_FY, , , , , , "Segment Name") 
This will provide you the last 5 segments for S&P Global on an absolute ranking basis.  
 
=CIQRANGE("NYSE:SPGI", "IQ_BUS_SEG_NAME", 1, 5, IQ_FY, , , , , , "Segment Name") 
This will provide you the last 5 segments for S&P Global on a relative ranking basis.  

 

As Presented Financials 
The formulas for As Presented Financials in the Financials tab of the Formula Builder also include options for 
Absolute and Relative Ranking.  The difference between Absolute Ranking and Relative Ranking is the order in 
which the segments are displayed.  Note that As Presented Financials must be retrieved in “blocks”—for 
example, on the Income Statement, revenues will be retrieved as one block and expenses as another.  
 

• Absolute Ranking retrieves the As Presented line items in the same order each and every year.   Each 
line item is assigned a Line Item ID Number that is locked in the database.  New line items from filings 
are assigned their own Line Item ID Number and are added to the end of the list. 
 

• Relative Ranking retrieves the As Presented line items in the order exactly as they appear in the latest 
available financial document.   
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Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_REV_NAME_AP_ABS", 1, 5, , , , , , , "Revenues Line Item Name") 
This will provide you the last 5 As Presented Line Items for Revenues for S&P Global on an absolute ranking basis.  
 
=CIQRANGE("NYSE:SPGI", "IQ_REV_NAME_AP", 1, 5, , , , , , , "Revenues Line Item Name") 
This will provide you the last 5 As Presented Line Items for Revenues for S&P Global on a relative ranking basis. 

 

Detailed Estimates 
You can use detailed estimates formulas to retrieve individual analyst estimates for a specific company.   
These can be retrieved for all forward and historical periods, depending on your capabilities. 
 
To retrieve detailed estimates, you must first pull in the contributors and their corresponding IQC identifiers.  
Since the contributor coverage can change from period to period, you should keep the Period and "As of" Date 
parameters in your range of detailed estimates consistent with those in your Contributor Name and 
Contributor ID formulas. 
 
You can access all the contributor identifiers for detailed estimates in the Contributor Index tab of the 
Detailed Broker Estimates template. 
 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_CONTRIB_ID_DET_EST", IQ_FY + 1, , , , , , "Contributor ID") 
This will provide you the Contributor IDs for S&P Global for the next fiscal year. 
 
=CIQ ("NYSE:SPGI", "IQ_REV_DET_EST", IQ_FY + 1, , , , , , "IQC4") 
This will provide you S&P Global’s detailed revenue estimate from Credit Suisse for the next fiscal year. 

 
 
Key Developments 
You can construct a range formula for key developments.  However, this functionality is unavailable in the 
Formula Builder.  You can use the formula below to find the Key Development IDs: 
 

=CIQRANGE("Ticker", "IQ_KEY_DEV_ID",  "Start Date", "End Date", "Category Type", , , , "Key 
Developments") 

 
Note: By default, the formula will retrieve Key Developments for a year prior to your End Date.  You cannot retrieve 
key developments for more than a year prior to your End Date. 

 
The formula below will retrieve the Key Development headline from the range of IQKD identifiers: 
 

=CIQ("Key Development ID", "IQ_KEY_DEV_HEADLINE") 
 
Additional metrics are as follows: 

• IQ_KEY_DEV_DATE 
• IQ_KEY_DEV_HEADLINE 
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• IQ_KEY_DEV_TYPE 
• IQ_KEY_DEV_SOURCE 
• IQ_KEY_DEV_TIME 

 

Example(s): 

=CIQRANGE("NYSE:SPGI", "IQ_KEY_DEV_ID", "-1Y", "07/15/2016", , , , , "Key Developments") 
This will provide you the key developments for S&P Global between the two dates specified. 

 
You can retrieve different categories of Key Developments by choosing the Category Type in Parameter 5.  If 
you would like to retrieve multiple categories of Key Developments with the same formula, you can type the 
desired category IDs into a single cell separated by commas and reference the cell in Parameter 5 in your 
formula.  Leaving Parameter 5 blank will retrieve all key developments for the selected period. 
 
The Major Categories for Parameter 5 are as follows: 
 
Major Category ID 
Company Forecasts and Ratings C1 
Announced/Completed Transactions C2 
Potential Transactions C3 
Listing/Trading Related C4 
Potential Red Flags/Distress Indicators C5 
Results Announcements/Corporate Communications C6 
Customer/Product Related C7 
Corporate Structure Related C8 
Dividends/Splits C10
LCD News C11
 
The Sub-Types for Parameter 5 are as follows: 
 
Sub-Type ID Sub -Type ID 
Seeking to Sell/Divest T1 IPOs T85
Seeking Acquisitions/Investments T3 Follow-on Equity Offerings T86
Seeking Financing/Partners T5 Fixed Income Offerings T87
Bankruptcy Related T7 Derivative/Other Instrument Offerings T88
Delayed SEC Filings T11 Bankruptcies Files T89
Delistings T12 Bankruptcies Concluded T90
Executive/Board Changes - Other T16 Emerged from Bankruptcy T91
Discontinued Operations/Downsizings T21 End of Lock-Up Period T92
Strategic Alliances T22 Shelf Registration Filings T93
Client Announcements T23 Special Dividend Announced T94
Accounting Issues/SEC Inquiries T24 Index Constituent Adds T95
Lawsuits & Legal Issues T25 Special/Extraordinary Shareholders Meetings T97
Corporate Guidance - Lowered T26 Potential Privatization of Government Entities T99
Corporate Guidance - Raised T27 Ex-Div Date (Special) T100
Announcement of Earnings T28 Executive Changes - CEO T101
Corporate Guidance - New/Confirmed T29 Executive Changes - CFO T102
Business Expansions T31 LCD Institutional Loan News T103
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Business Reorganizations T32 LCD Trend News T104
Buybacks T36 LCD Fallen Angel News T105
Product-Related Announcements T41 LCD Debtor-in-Possession News T106
Debt Financing Related T42 LCD Middle Market News T107
Restatements of Operating Results T43 LCD High-Yield Bond Story News T108
Labor-Related Announcements T44 LCD Leveraged Buyout News T109
Dividend Affirmations T45 LCD People Story News T110
Dividend Increases T46 LCD Sponsored Deal News T111
Dividend Decreases T47 LCD M&A News T112
Earnings Calls T48 LCD Distressed News T113
Guidance/Update Calls T49 LCD Break Price News T114
Shareholder/Analyst Calls T50 LCD Investment Grade Loan News T115
Conference Presentation Calls T51 LCD Repricing News T116
Special/M&A Calls T52 LCD Dividend News T117
Stock Splits & Significant Stock Dividends T53 LCD Repayment News T118
Stock Dividends (<5%) T54 LCD Mezzanine Debt News T119
Expected Earnings Release Date T55 LCD Second-Lien News T120
Name Changes T56 LCD High-Yield Europe News T121
Exchange Changes T57 LCD Covenant-Lite News T122
Ticker Changes T58 LCD Cross-Border Deal News T123
Auditor Going Concern Doubts T59 LCD CLO News T124
Address Changes T60 LCD Secondary Story News T125
Delayed Earnings Announcements T61 LCD Amendment News T127
Annual General Meetings T62 LCD Communications News T128
Considering Multiple Strategic Alternatives T63 LCD European News T129
Ex-Div Date (Regular) T64 LCD Price-Flex News T130
M&A Rumors and Discussions T65 LCD Global News T131
Credit Rating - S&P - Upgrade T68 LCD Ratings News T132
Credit Rating - S&P - Downgrade T69 Composite Units Offerings T134
Credit Rating - S&P - Not-Rated Action T70 Structured Products Offerings T135
Credit Rating - S&P - New Rating T71 Public Offering Lead Underwriter Change T136
Credit Rating - S&P - CreditWatch/Outlook Action T72 Spin-Off/Split-Off T137
Impairments/Write Offs T73 Announcements of Sales/Trading Statement T138
Debt Defaults T74 Sales/Trading Statement Calls T139
Index Constituent Drops T75 Expected Sales/Trading Statement Release Date T140
Legal Structure Changes T76 LCD Bids Wanted in Competition T141
Changes in Company Bylaws/Rules T77 LCD Company Buys Back Outstanding Bank Debt T142
Board Meetings T78 LCD Debt Exchange T143
Fiscal Year End Changes T79 Expected Earnings Release Date (CIQ Expected) T144
M&A Transaction Announcements T80 LCD Loan Credit Default Swap News T145
M&A Transaction Closings T81 LCD Credit Defaults Swap News T146
M&A Transaction Cancellations T82 LCD Default News T147
Private Placements T83 LCD Deal Launch News T148
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Additional CIQ Functions: CIQMATRIX & 
CIQSPLIT 
 
CIQMATRIX (Download Financials) 
The CIQMATRIX function can be used to download financials for the Standard, Industry Specific, and As 
Presented Income Statement, Balance Sheet, and Cash Flow directly into Microsoft Excel with one formula.  It 
was introduced with the S&P Capital IQ Excel Plug-in Version 8.0 and can be found in the Download Financials 
folder in the Formula Builder. 
 
Standard:  Pulls the Standard template for the specified company.  This will retrieve the same line items for all 
companies. 

• IQ_INCOME_STATEMENT_STANDARD  
• IQ_INCOME_STATEMENT_STANDARD_CO  
• IQ_BALANCE_SHEET_STANDARD  
• IQ_BALANCE_SHEET_STANDARD_CO  
• IQ_CASH_FLOW_STANDARD  
• IQ_CASH_FLOW_STANDARD_CO  

 
Industry Specific:  Pulls the Industry Specific template for the specified company.  If a company does not have 
an Industry Specific template, this will retrieve the same line items as the Standard template. 

• IQ_INCOME_STATEMENT_INDUSTRY  
• IQ_INCOME_STATEMENT_INDUSTRY_CO  
• IQ_BALANCE_SHEET_INDUSTRY  
• IQ_BALANCE_SHEET_INDUSTRY_CO  
• IQ_CASH_FLOW_INDUSTRY  
• IQ_CASH_FLOW_INDUSTRY_CO  

 
As Presented:  Retrieves the line items as the company reported them on their latest financial document. 

• IQ_INCOME_STATEMENT_AP  
• IQ_BALANCE_SHEET_AP  
• IQ_CASH_FLOW_AP  

 
Metrics ending in _CO are Company Specific—they will display only the line items which the company has 
values for, so you will see a truncated version of the Standard and Industry Specific templates. 
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The prefix of the formula will be =CIQMATRIX. 
 

• Parameter 1: Ticker or CIQ Identifier 
• Parameter 2: Metric ("IQ_DATAPOINT") 
• Parameter 3: Period Type 
• Parameter 4: Blank 
• Parameter 5: Filing Version 
• Parameter 6: Date Comparison 
• Parameter 7: Currency 
• Parameter 8: Currency Conversion Mode 
• Parameter 9: Period Order 
• Parameter 10: Label 

 
The parameters in bold are required.  The "As of" Date will default to today.  All other parameters will default to 
the options in Settings. 
 

Example(s): 

=CIQMATRIX("NYSE:SPGI", "IQ_INCOME_STATEMENT_STANDARD", IQ_FY - 1, , , , , , , "Income Statement - Standard") 
This will provide you the Standard Income Statement for S&P Global for the last 2 fiscal years. 

 
 
CIQSPLIT 
Microsoft Excel limits the length of cell contents (text)—only 1,024 characters will display in a cell.  This may 
cause business descriptions to be cut off when you retrieve them in Excel. 
 
The CIQSPLIT function allows you to format the business description into rows that can be adjusted to fit any 
style and format.  The parameters are as follows: 
 

=CIQSPLIT(BUSINESS DESCRIPTION REFERENCE, ROW REFERENCE, # OF CHARACTERS PER ROW) 
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Appendix 
Date Functions 
 
Excel Date Functions: 
 
EDATE 
The EDATE function returns the date that is the indicated number of months before or after a specified date.  
The formula is as follows: 
 
=EDATE (Start Date, Months) 
 

Example(s): 

=EDATE("3/20/2013",-1) 
This will provide you the date one month before 3/20/2013. 
  
=EDATE("3/20/2013",2) 
This will provide you the date two months after 3/20/2013. 

 
Note: The Analysis ToolPak add-in must be enabled for the EDATE function to work. 

• Excel 2003: Tools → Add-Ins 
• Excel 2007: Home Button → Excel Options → Add-Ins 
• Excel 2010: File → Options → Add-Ins 

 
 
S&P Capital IQ Date Functions: 
 
The formula to pull in today’s date is as follows: 

=CIQGETDATE(IQ_TODAY) 
 
This formula can also be used to retrieve historical dates.  For example, the formula for yesterday’s 
date would be =CIQGETDATE(IQ_TODAY) - 1 

 
Note: You should not use the Excel functions =NOW() and =TODAY(), as they will conflict with the S&P Capital IQ 
Excel Plug-in. 

 
The formula to pull in a company's period date for a specific period is as follows: 

=CIQ("NYSE:SPGI", "IQ_PERIODDATE", IQ_FY) 
This will provide you the period date for S&P Global’s most recently completed fiscal year. 

 
The formula to pull in a company's filing date for a specific period is as follows: 
 

=CIQ("NYSE:SPGI", "IQ_FILINGDATE_IS", IQ_FY) 
This will provide you the filing date for S&P Global’s most recently completed fiscal year income 
statement.  (Please note that this works for the balance sheet and cash flow statements as well.) 
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The formula to pull in a company’s first pricing date is as follows: 
=CIQ("NYSE:SPGI", "IQ_FIRSTPRICINGDATE") 
This will provide you the first date that S&P Capital IQ has pricing for S&P Global. 

 
The formula to pull in a company’s latest trading day is as follows: 

=CIQ("NYSE:SPGI", "IQ_PRICEDATE") 
This will provide you the latest date on which pricing is available for S&P Global. 

 
The formula to pull in a range of trading days between two dates is as follows: 

=CIQRANGE("NYSE:SPGI", "IQ_PRICEDATE", "07/15/2015", "07/15/2016") 
This will provide you all the trading days for S&P Global between 07/15/2015 and 07/15/2016. 

 

 
 


